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cOPyRiGHT AND TRADEMARKS
Evolis © 2022. All rights reserved.

Users must observe the copyright regulations applicable in their country. This manual must not be photocopied, translated, reproduced or transmitted, 
in whole or in part, for any reason and by any electronic or mechanical means whatsoever without the express written consent of Evolis.

All the information contained in this document is subject to change without prior notice.

Evolis cannot be held liable for any errors that may be found in this manual, or for any loss or damage arising accidentally or as a result of dissemination 
or use of this manual.

All Evolis printer models, Evolis Premium Suite® and Evolis High Trust® are trademarks of Evolis. All other trademarks belong to their respective holders.

WARRANTy
Refer to the warranty notice for warranty terms and conditions and limitations. it is available on myplace.evolis.com.

Register online at myplace.evolis.com to receive our special offers and general information. 

ENViRONMENTAL iNFORMATiON
Evolis is committed to helping the environment by reducing the energy consumption of its products.

RECYCLING OF END-OF-LIFE PRODUCTS
The manufacture of the equipment that you have purchased required the extraction and use of natural resources. it may contain materials that are 
hazardous to health and the environment.

To prevent the dispersal of such materials into our environment and reduce the pressure on our natural resources, we recommend that you use 
existing collection systems. These systems appropriately re-use or recycle most of the materials in your end-of-life equipment.

For more information on collection, re-use and recycling systems, contact your local or regional waste management body.

For more information, visit our website at myplace.evolis.com or send an email to info@evolis.com.

icONS
The following icons are used in this manual to highlight important information:

NOTE Information providing further details or depth about specific points in the main text.

!
indicates that failing to take the recommended action is liable to damage the printer

A video showing the procedure is available on myplace.evolis.com

https://myplace.evolis.com/s/?language=en_US
https://myplace.evolis.com/s/?language=en_US
https://myplace.evolis.com/s/?language=en_US
https://myplace.evolis.com/s/?language=en_US


6

PRiMAcy 2

ABOUT yOUR NEW PRiNTER
Thank you for choosing an Evolis printer. Using your new printer, you will be able to create a wide variety of high-quality cards and badges which can 
be printed in various thicknesses, colors and styles. This printer uses consumables and accessories available from Evolis. 

For further details and view all technical specifications, visit our website at www.evolis.com >Card printers >Printer model >Technical specifications.

Certifications and declarations of conformity:
cE, UKcA, icES, Vcci, BiS, ccc, Kc, EAc, ROHS, 

Fcc (Evolis contact: Evolis, Rising Sun Mills, 188 Valley St., Suite 421, Ri 02909 Providence, evolisnortham@evolis.com)

Icons on the printer label:

Evaluation for apparatus only based on altitude not exceeding 2000m, therefore it’s the only operating condition applied for the 
equipment. There may be some potential safety hazard if the equipment is used at altitude above 2000m. 

Evaluation for apparatus only based on temperate climate condition, therefore it’s the only operating condition applied for the equipment. 
There may be some potential safety hazard if the equipment is used in tropical climate region.

Reminder to use existing collection facilities.

Dimensions
• Printer (HxWxD) without locking system and with 100-cards feeder: 246,2x 204.95x 381.2mm

Weight
4.11 kg

Connectivity
USB (1.0, 1.1, 2.0, 3.0), Ethernet, Wi-Fi (option)

Environmental Conditions
• Standard operating temperature: 15°c / 30 °c (59°F / 86°F)

• Min / Max operating temperature and humidity rate: 0° / 40° c (32°F / 104°F) and 20% to 65% non-condensing

• Min/max storage temperature: –5°c / +70°c (23°F / 158°F)

• Storage humidity: 20% to 70% without condensation

• Operating ventilation: free air

Electrical Information
• Power supply unit: 100-240 Volts Ac, 50-60 Hz, 1.5A

• Printer: 24 Volts Dc, 2.5A

https://www.evolis.com/
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1. GETTiNG STARTED
UNPAcKiNG
your printer is supplied with several accessories that we ask you to look at closely.

This list may vary depending on your location.

The printer is shipped in special packaging designed to prevent any damage in transit. if you notice any visible damage, do not hesitate to contact the 
shipper and immediately inform your Evolis dealer, who will tell you the procedure to follow.

Evolis takes great care over the quality of its packaging and we ask that you keep this packaging somewhere clean and dry.

!
The full original packaging (outer box, inner wedges and protective bags) is required in the event that the printer is returned. if the 
printer is returned without its original packaging and components are damaged in transit, these components are no longer covered 
by the warranty. you will be charged for new packaging for shipping the printer back to you.

Accessories supplied with your printer:
• Power supply unit – FSP type FSP060-RAAK3

• Mains power cable

• USB cable

• Reject box/Rear output hopper

• Starter cleaning kit

• Quick installation guide with QR code to access the driver

• card designing software cardpresso

!
if any of these components are missing, please contact your Evolis dealer.

Use only the power supply unit supplied with your Evolis printer.

Use only the USB cable supplied with your Evolis printer.

NOTE The Evolis printer must be placed in a dry location, protected from dust and drafts but well-ventilated. Make sure to keep your printer 
on a flat, sturdy surface able to bear its weight.
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DEScRiPTiON OF THE PRiNTER AND iTS FUNcTiONS

!
Access to the side panels of the machine and the option module fitting/removal areas is restricted to your retailer/installer or 
to experienced users. Always disconnect the machine from the power supply (unplugged) before performing work on it.

A

B

c

D

E

A card input feeder (100 cards)

B internal output hopper

c LcD Screen (option)

D Power button

E LED control Panel

NOTE if the printer is equipped with an LcD screen, refer to the corresponding user guide for more information.
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K J

i

H

G

F

L

N

Protective cover

O

M

F Place for reject box (See "Managing the reject box/rear output hopper", 
page 18)

G Location for security locking (option)

H Power cable socket

i Ethernet connector 

J USB socket (type A)

K USB socket (type B)

L cleaning Roller

M Side panel opening mechanism

N Thermal print head with protective cover 

O card thickness adjustment gauge
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P Q

R
S

P Printer serial number label

Q Dust filter

R Location for double-sided printing activation key (option)

S Side panel opening mechanism
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iNSTALLATiON 
connecting the Printer Power Supply cable

!
The printer must be connected to a properly protected and earthed electrical installation.

Fi: Laite on liitettävä suojamaadoitus koskettimilla varustettuun pistorasiaan.

NO: Apparatet må tilkoples jordet stikkontakt.

SE: Apparaten skall anslutas till jordat uttag.

DK: Printeren skal tilsluttes til en korrekt beskyttet og jordforbundet el-installtion.

• Connect the power cable to the power supply unit, then plug the power supply unit connector into the printer.

• Next, plug the end of the power cable into an earthed power socket.

The printer is powered on: the control panel lights up showing the printer is working 
properly. 

if the control panel does not light up, please check the installation. 

!
Before attempting maintenance, make sure the power cable is unplugged. For your personal safety, ensure that the cable and power 
supply unit remain easy to access, especially in case of emergency.

NOTE To save energy, the printer automatically switches itself to standby mode after 10 minutes of inactivity. The printer switches 
to hibernation mode after 30 minutes in standby mode.

The standby settings can be configured in the Evolis Premium Suite. In standard standby mode, sending a print request restarts the 
printer and briefly pressing the control button (for 1 second) exits the printer from hibernation mode.
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installing Evolis Premium Suite
Evolis Premium Suite® is an all-in-one driver software solution, which enhances the user experience by making interactions between printer and 
computer more intuitive. Its advanced features automate printer configuration. 

It includes:
• A supervision of printers: printer status information, remaining ribbon capacity, etc.

• A powerful tool for printer settings

• A notification center to alert users when their intervention is required

• A printer management and maintenance station

• A series of wizards to guide you through cleaning and encoding operations, etc.

• An encoding station (magnetic encoding, etc.)

• A diagnostic tool

To install the print driver:

1 Go to the link dedicated to the driver (start.evolis.com/primacy2)

2 Download and launch the driver: Evolis Premium Suite®.

3 A program guides you through the entire installation process. it is possible to select Standard or Minimal installation: standard installation is 
recommended as it includes notification and supervision features.

4 At the end of the installation process, you need to restart the computer.

5 connect your computer to the printer trough the USB cable. 

!
Do not connect the USB data cable before the installation of the printer driver is complete. 

Follow the instructions of the wizard carefully.
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connecting to a network
All Evolis printers can be fitted with a TCP/IP network connection. This function is available as standard on Primacy.

Out of the box, the printer comes configured in DHCP mode (Dynamic Host Configuration Protocol), which means that its IP address is supplied by 
the network. 

In addition to these basic settings, the network administrator has the option of configuring the printer differently in order to comply with the constraints 
imposed by the corporate LAN:

• Printer connected in a subnet, in DHcP mode

• Printer connected to a subnet in fixed IP address mode, with WINS resolution

• Printer connected to a subnet in fixed IP address mode, without WINS resolution

The Ethernet connection wizard available in Evolis Premium Suite® automatically detects all installed Evolis printers.

The user can define the following settings:

• iP address of the printer

• Subnet mask

• Gateway

• WiNS server

NOTE Evolis printers fitted with a TCP/IP network interface have an embedded http server.

!
changing the printer’s basic settings without prior knowledge of the layout of the LAN in question or without genuine technical 
knowledge may result in a malfunction of the printer, and may even extend to more widespread failure of all or part of the LAN. 
contact your System and Network Administrator before connecting to or changing the settings for your local area network.

For further details, refer to the Network Administrator Manual.
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Ribbons
Evolis High Trust® ribbons optimize your printer’s operation and avoid causing damage to it. The use of ribbons from other suppliers may damage the 
printer and voids the manufacturer’s warranty for the printer.

For optimum print quality, Evolis recommends that the printer is fully cleaned every time the ribbon is changed. See "Printer cleaning", page 51.

Fitting the ribbon

NOTE The printer automatically recognizes the ribbon inserted. 

1 Open the cover. 2 insert the ribbon as shown. 3 Close the cover and press until a  click is 
heard.

NOTE Primacy 2 ribbons are different from Primacy 1 ribbons. They cannot be swapped. 
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inserting cards

NOTE For optimum quality, the cards used must be ISO 7810 certified.

Use only the card types recommended by Evolis.

Do not touch the printable surface of the cards to preserve print quality.

Do not use cards that are damaged, folded, embossed or dropped on the floor.

Keep your cards protected from dust.

100
x0.76mm

1 Open the card feeder. 2 insert the cards, a maximum of 100 cards 
of  thickness 0.76mm. Ensure the cards are 
positioned as illustrated in the diagram.

3 close the feeder.
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Removing printed cards
Once the print cycle is complete, cards are delivered into the output hopper below the card feeder. 

This output hopper is designed to collect printed and/or encoded cards. 

The output hopper has a maximum capacity of 100 x 0.76mm cards. 

100
x0.76mm

NOTE if the locking option is installed, maximum capacity is reduced to around 50 x 0.76mm cards.



17

PRiMAcy 2

Adjusting card thickness 
The printer is equipped with a manual card thickness adjustment mechanism which can be reached through the card feeder when open. 
The printer accepts cards between 0.25mm and 1.25mm thick (10 to 50mil). The factory setting is 0.76mm.

To adjust card thickness: 

1 Open the card feeder and remove cards if 
necessary

2 Adjust the thickness of the cards used by 
moving the gauge from right to left to the 
desired card thickness.

3 close the feeder

NOTE card thicknesses is written on the card box:
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Managing the reject box/rear output hopper
The printer is fitted with a removable reject box which is positioned behind it.

The reject box can hold 50 cards (0.76mm - 30mil).

50
x0.76mm

To empty it, open the box and remove the cards in it.

it is recommended to empty the reject box regularly

NOTE The reject box can be used as a hopper to optimise the production flow of cards when continuous ribbons are used. 

Preloading cards enables to optimise the production flow. To activate this feature, go to Evolis Premium Suite and click the printer 
name>Printer settings>Printing>Resolution and Speed>Enable automatic card preloading.
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2. MANAGiNG PRiNT SETTiNGS
AccESSiNG SETTiNGS
Evolis Premium Suite enables changes of specific predefined settings through its user-friendly interface on Windows platforms.

NOTE contact your Evolis dealer for advice and assistance before making any change of setting.

To access this application:

1 Double-click on Evolis Premium Suite shortcut or, from the Start button on the bottom left of your screen in the Windows task bar, select All 
programs>Evolis Card Printer>Evolis Premium Suite

2 The application displays all connected Evolis printers. Select the desired printer.

3 Go to Printer Settings to change the settings.

NOTE On Macintosh platforms, refer to Macintosh driver User Guide. 
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ESSENTiAL SETTiNGS
Once the ribbon is installed, the Evolis printer automatically adapts its parameters and settings to suit the ribbon.

Action Setting in Evolis Premium Suite

Go to Ribbon tab and click on Enable duplex printing to use the double-side printing 
feature. 

Go to Card tab and select the orientation: Landscape or Portrait

click on Display advanced settings (on the right part of the window) to make more 
precise parameters visible.

Go to Card input/output and select the adequate options

Resolution and Speed tab: change the resolution if needed

Go to Colors tab to manage black dots on the card

Go to Overlay tab to manage the areas of the card to cover with overlay
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3. PRiNTiNG AND iNTERAcTiNG WiTH THE PRiNTER
PRiNTiNG A cARD
A large number of applications allow documents to be printed (for example MS Word, MS Access, MS Excel, MS PowerPoint).

Read the following examples to gain familiarity with the layout of a card and configuration of its formatting and printing.

On Microsoft® Word
1 After having set the Evolis printer as the default:

• Start the MS Word application.

• Select Landscape in the Orientation section.

• change the size of your document by selecting the type CR80 (or by customising the document with the dimensions 8.6cm x 5.4cm and margins 
of 0.1cm).

2 customise your card by adding the various items that go to make up a card: logo and illustration, identification photo, fixed and variable texts, 
barcode, etc.

3 click on File and then on Print.

On cardpresso 
1 Open cardpresso application and select CR80 card type. 

2 The card design window is displayed. you are ready to customise your card by adding the various items that go to make up a card: logo and 
illustration, identification photo, fixed and variable texts, barcode, etc.

3 click on File>Print, select Primacy 2 printer and click on Print. 

NOTE For more information, refer to the knowledge base on myplace.evolis.com or cardpresso embedded Help.

On TextEdit 
1 Open TextEdit application

2 Go to File> Page Setup>Paper Size>Manage Custom Sizes

3 click on + and add a new format as follows: width : 55mm, height : 86mm, top : 0mm, left : 0mm, right : 0mm, bottom : 0mm

4 Save the new format with the name Card and click on OK

5 close Text Edit

6 Go to System Preferences and select Printers and Scanners. On Default paper size, select Card

7 Go back to TextEdit and design your card. 

8 click on File>Print and select Primacy 2 printer.

https://myplace.evolis.com/s/?language=en_US
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USiNG THE cONTROL PANELS
LED control panel

OFF

STEADy LiGHT

FLASHiNG

PRINTER READY
• The printer is ready 

to receive data.

PROCESSING
• The printer is receiving 

data.

RIBBON
• No ribbon in the printer.

• End of ribbon.

• The ribbon is not correctly fitted.

• The ribbon is torn.

• The ribbon is not recognised.

Check the condition of the ribbon in the printer. If you have a 
print job in progress, this restarts with a new card.

CARDS
• No cards in the card feeder.

Put cards back into the feeder – the process starts again.
• card loading error.

Check cards have been loaded. For any other problems 
contact your Evolis dealer.

PRINTER COVER OPEN 
• The printer cover is open.

Close the cover again. The printer starts up.

MECHANICAL ERROR
• card jammed in the printer.

• Mechanical component fault.

Open the cover and hold down the power button in 
order to eject the jammed card. 
If the problem persists, contact your Evolis dealer for 
assistance.
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REGULAR CLEANING
(after 1,000 cards have been inserted)

• The printer must be cleaned.

(See "Regular printer cleaning", page 51)

ADVANCED CLEANING
• The printer requires advanced cleaning.
(See "Advanced cleaning", page 55)

CLEANING
(after 1,200 cards have been inserted)

• The printer must be cleaned to avoid the risk of the 
warranty being voided.

COOLING MODE
• The cooling system has been activated.

The printer pauses for a few seconds and restarts once it has 
returned to its normal operating temperature.

FIRMWARE UPDATE
• The printer is updating its firmware.

The printer restarts following the update.

Wi-Fi IS ON (option)
• The wireless (Wi-Fi) connection is enabled.

The printer is ready to be used.
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LcD screen
LcD screen is touch-sensitive: it enables easy interaction with the printer. 

Useful messages on the printer processes are displayed. 

They enable you to take actions and perform a good supervision of the printing jobs.

There are various types of statuses:

• Green: the printer is ready to print or in the process of printing, encoding, cleaning, etc.

• Orange or red: processes cannot be performed due to a small or serious issue



25

PRiMAcy 2

Scan the flash code to access information on myplace.evolis.com to solve the issue. 

• Red: processes cannot be performed due to a serious issue. The user action is needed:

Scan the flash code to access help

Launch the process again

Cancel the process

NOTE For more information, refer to the LCD screen user guide.

https://myplace.evolis.com/s/?language=en_US
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Pop-ups 
Evolis Premium Suite offers a service allowing the printer to communicate with the user through notifications.

There are several types of notifications:

• Messages about the maintenance of the printer.

• Messages and alerts associated with the ribbons, their compatibility with your printer or the nature of your print requests.

• Warnings about problems which have stopped the printer.

When the Evolis Premium Suite is active, a small icon is displayed in the bar on the bottom right of your computer screen.

The color of the icon varies according to the status of the printer:

• Green: Printer ready

• Orange: information message issued – printing stopped

• Red: Warning message issued – printing stopped

• Grey: Printer in hibernation mode, disconnected or communication is interrupted.

When a notification is issued, it is displayed in a window of the following type:

cancel the printing task

Notifications can be disabled. Click on User Preferences then untick the Enable notifications button.

NOTE Interrupting the pop-ups service is only recommended if there is a conflict with other applications installed on the computer. The 
pop-ups service is the best way to properly monitor the printer from your workstation.

Get additional help on myplace.evolis.com.

https://myplace.evolis.com/s/?language=en_US
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4. ADVANcED FEATURES
AVAiLABLE OPTiONS
Options may be already integrated in the printer or provided separately. in this case, their shipped kits contain all instructions for installation.

Refer to the driver User Guides for all settings linked to these two possibilities.

Basic internal locking Encoding stations Duplex activation

(double-sided printing)

200-cards extension feeder Wi-Fi network Scanning Kineclipse

Lamination module
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INSTALLING THE 200-CARDS EXTENSION FEEDER
An extension for the feeder can be installed on Primacy 2.

The standard version of Primacy 2 has a feeder that can hold 100 cards. When the extension is installed, the feeder can hold 200 cards. 

!
Remove all cards from the feeder before performing the installation.

Unplug the printer before performing the installation.

Keep the feeder weight. it is needed to go back to the standard version.

1 Fully open the feeder. 2 Open the cover. 
insert the block to hold the  upper feeder in 
place as shown and then close the cover.

3 Remove the feeder weight as shown.

4 insert the extension until you hear a click 5 insert cards in the feeder. 
Put the weight on top of the cards. 
close the door of the feeder. 
Plug the printer.

6 The 200-cards extension is installed and the 
printer is ready to be used
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CONFIGURING A WI-FI NETWORK
The frequency of Wi-Fi network must be compatible with the printer Wi-Fi card:

• connect1: 2.4 GHz

• UBox: 2.5 GHz/5 GHz

1 To configure the printer in Wi-Fi, contact the Support team.

2 check the availability of a Wi-Fi network

Wi-Fi icon

LEDLcD
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USiNG THE UV EFFEcT WiTH THE OVERLAy PANEL
The O (= overlay) panel(s) of the YMCKO, 1/2 YMCKO, YMCKOK, and YMCKOO ribbons include fluorescent pigments. 

UV-light reflective features, such as logos, texts and photos can be inserted in overlay layers. 

This addition of layer adds an extra level of security to your cards:

• With the standard color ribbons (yMcKO, 1/2yMcKO, yMcKOK, 1/2yMcKOKO) combined to lamination

!
Lamination is mandatory to protect color printing.

• With the yMcKOO ribbon (no lamination required)

!
The UV effect settings are only activated when the adequate ribbon is inserted into the printer.

To insert UV-light reflective element on your card:

1 From Evolis Premium Suite, go to Printer Settings and select Printing>Overlay>UV effect. 

2 Select the file to apply.
• Among generic designs proposed in the list

• your own custom design

Fixed Data Dynamic Data

Data inserted are the same on all cards (e.g., a company logotype). The 
insertion is performed through the EPS

Data inserted are different on each card (e.g. a picture).

The insertion is performed in Cardpresso software (>XL version)

Example of UV effect bitmap file Rendering on the card.

3 Apply lamination on the card if necessary.
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Overlay settings
Overlay settings can be adjusted in the Evolis Premium Suite.

• The overlay can be applied on the whole surface of the card

• The overlay can be disabled (when lamination is applied for example)

• The overlay can be applied only on some areas of the card

• Two layers of overlay can be applied (with the yMcKOO ribbons).

NOTE Two layers of overlay increase protection against wear and tear 

The abrasion resistance is 3 times better with the YMCKOO ribbon compared to standard YMCKO ribbon protection

DOUBLE-SIDE PRINTING
Activation key
A simplex printer (prints only on one side) can be upgraded into a duplex printer (prints on both sides).

To obtain the activation key for that upgrade, contact your Evolis dealer.

Proceed as follows:

1 Turn the printer on 2 Open the printer cover. 3 Remove the ribbon 4 insert the key as shown
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5 close the cover 6 The ON/OFF button flashes 
until the end of the process. 
The LED or LcD panel gives 
information about the process. 
The printer restarts at the end 
of the update.

7 Open the cover and remove the 
activation key

8 insert the ribbon

9 close the cover if necessary, a wizard is available in Evolis Premium Suite to perform the 
activation
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Double-side printing with a simplex printer
in case the double-side printing feature is not activated on your printer, proceed manually as follows: 

1  2  3  

REWRITE (OPTION)

The rewrite feature enables to erase and print, on rewritable cards only. 

Thanks to the inner color layer of the rewritable card, there is no need to use the ribbon for 
the rewrite feature. 

1 Remove the ribbon and close the printer cover.

2 Open the feeder and insert rewritable cards. 
if other cards are already inserted, remove them from the feeder. 

3 From Evolis Premium Suite, go to Printer Settings>Printing>Rewrite. 

4 Select Rewrite>Rewrite option, then the type of card:
PVc body that may be blank 
or pre-printed

Thermo-sensitive layer that 
contains ink which can be 
either revealed or hidden, 
depending on the setting 
defined

5 Select the printing mode:
• Erase /rewrite (previous data on the card are erased before printing): the full surface of 

the card

• Customized rewritable areas: click on the white card area to define the rewritable area 
only. A file can be selected as a background to help and define the rewriteable area. 

• Write only: there is no erase of the card before printing
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LAMiNATiON MODULE

!
Access to the side panels of the machine and the option module fitting/removal areas is restricted to your retailer/installer or 
to experienced users. Always disconnect the machine from the power supply (unplugged) before performing any work on it.

Description of the lamination module

F Output Hopper

A Lamination Module

B Primacy 2 Printer

c control Panel

D Space for output hopper

Printer LEDs
Lamination Module LEDs

cards and ribbon

cleaning

Lamination Module or 
Printer

See “interacting with 
the lamination module”, 
page 39.

B

A 

c

D 
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E

F

G

L

M
N

H

i

J

K

E Location for security locking

F Platform for lamination module installation 

G Heating head 

H Axles

i Jam-clearing wheel

J card leveler

K Dust filter

L Power cable socket

M Serial number label
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installation of the lamination module

!
Install the printer and the lamination module on a flat surface.

1 Place the printer on the installation platform 
("Printer" side)

2 connect the printer power supply and 
USB cable. See “connecting the Printer 
Power Supply cable”, page 11 and See 
“installing”, page 12

3 connect the lamination module power 
supply cable.

4 Place the lamination module on the 
installation platform ("Laminator" side)

5 Make sure that infra-red connectors are 
facing each other and the two modules are 
aligned.
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Once the printer and lamination module are connected, follow the instructions to power the machine on.

1 Plug the lamination module to an earthed power socket

2 Plug the printer to an earthed power socket

3 connect the printer USB cable to the computer
The system is powered on: the Primacy Lamination control panel lights up showing that the machine is working properly.

NOTE To save energy, the printer and the lamination module automatically switch to standby mode after 10 minutes of inactivity. They 
switch to hibernation mode after 30 minutes in standby mode.

The standby settings can be configured in the Evolis Premium Suite. In standard standby mode, sending a print request restarts 
the printer and briefly pressing the control button (for 1 second) takes the printer out of hibernation mode.

Make sure the card thickness gauge is well adjusted on the printer. See “Adjusting card thickness”, page 17.

inserting cards and ribbon
See “Ribbons”, page 14 and See “inserting cards”, page 15.
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Inserting lamination film

1 Push the door button to open the lamination module door

2 Insert the lamination film until you hear a click on each roll

3 close the lamination module door
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Removing laminated cards

Once the print and lamination cycle is complete, the cards are issued into the output hopper at the rear side  
of the lamination module. This output hopper is designed to collect the printed cards that are laminated and/
or encoded. 

The capacity of the output hopper is 100 cards maximum with 0.76mm (30mil) thickness. 

interacting with the lamination module
Although the lamination module was designed to operate independently and keep user involvement to a minimum, it may prove useful to be aware 
of the main warning messages.

Control button

Cards and ribbon
Printing module

Cleaning
Printing module

Information
Printing module

Cards and film
Lamination module

Cleaning
Lamination module

Information
Lamination module

OFF

STEADy LiGHT

FLASHiNG

LEGEND
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NOTE The printer may be equipped with an LcD screen instead of the control panel. Refer to the LcD screen user guide for more information.

PRINTER AND LAMINATION MODULE READY
• The printer is ready to receive data.

• The lamination module is ready.

PROCESSING
• The printer is receiving data.

• Lamination in process.

RIBBON
• No ribbon in the printer.

• End of ribbon.

• The ribbon is not correctly fitted.

• The ribbon is torn.

• The ribbon is not recognized.

Check the condition of the ribbon in the 
printer. If there is a print job in progress, it 
restarts with a new card.

CARDS
• No cards in the card feeder.

Reload cards into the feeder – the process 
starts again.
• Error loading cards.

Check the cards are loaded. For any other 
problems, contact your Evolis dealer.

PRINTER COVER OPEN 
• The printer cover is open.

Close the cover again. The printer restarts.

MECHANICAL ERROR
• card jammed in the printer.

• Mechanical component fault.

Open the cover and hold down the control button to eject 
the jammed card. 
If the problem persists, contact your Evolis dealer for 
assistance.

FILM
• No film in the lamination module. 

• No more film.

• The film is not correctly fitted.

• The film is torn.

• The film is not recognized.

Check the condition of the film in the printer.

LAMINATION MODULE DOOR
• The door of the lamination module is open.

Close the door. The lamination restarts.

MECHANICAL ERROR
• card jammed in the lamination module.

• Mechanical component fault.

If the problem persists, contact your Evolis dealer for 
assistance.
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REGULAR CLEANING OF THE PRINTER
(after 1,000 cards inserted)

• The printer must be cleaned.

See “Regular printer cleaning”, page 51

ADVANCED CLEANING OF THE PRINTER
• The printer requires advanced cleaning.

See “Advanced cleaning”, page 55

CLEANING OF THE PRINTER
(after 1,200 cards inserted)

• The printer must be cleaned to avoid the risk of the warranty 
being voided.

WAITING FOR CARD INSERTION OR REMOVAL
• The printer is waiting for a card to be inserted 

or removed.

Insert a card or remove the card from the 
manual feeder.

COOLING MODE
• The cooling system has been activated.

The printer pauses for a few seconds and restarts once it 
is back at its normal operating temperature.

FIRMWARE UPDATE OF THE PRINTER
• The printer is updating its firmware.

The printer is operational again after the 
update.

REGULATING TEMPERATURE
• The lamination module heats up for a few seconds and is 

reactivated when the required temperature is reached.

ADVANCED CLEANING OF THE LAMINATOR
• The lamination module requires advanced 

cleaning.

See “Lamination module cleaning”, page 
59

FIRMWARE UPDATE OF THE LAMINATOR
• The lamination module is updating its firmware.

The printer is operational again after the update.
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ENcODiNG OPTiONS
Encoding systems are used to customize magnetic stripes, and contact and contactless smartcards.

it is possible to install up to three types of encoder in the printer (magnetic stripe, contact and contactless smartcards) on your premises.

Magnetic stripe encoding
A printer fitted with a magnetic encoder works exactly the same way as a basic card printer.

The Evolis encoder encodes the magnetic stripes in a single pass then runs a data check.

Although able to be configured as high coercivity (HiCo) or low coercivity (LoCo) by a simple click in the EPS properties, Evolis magnetic encoders come 
factory-set for high coercivity (Hico).

Location of the magnetic encoder
The magnetic encoder is a module installed either in the factory or on site by your Evolis dealer. The read-and-write head is located under the path 
taken by the cards and before the print head. The encoding sequence for a card is always carried out before the printing.

To install the magnetic encoding station:

1 Refer to the instructions provided in the kit 

2 Use the installation wizard that is available in Evolis Premium Suite>Assistance & Maintenance>Maintenance>Printer Options

!
Use only magnetic stripe cards that comply with iSO 7810 and iSO 7811 standards.

The magnetic stripe must be moulded into the card to work properly.

Never use cards with a glued-on magnetic stripe.

When first installing the Evolis Premium Suite, the magnetic encoder functions need to be configured. 

Access the settings through Printer settings>Encoding>Magnetic.

Configure stripes to select the desired format for each stripe, according to the following table.

ISO 7811 magnetic encoding standards
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Stripe number Separator Density character set
Number of 
characters

1 Dots per inch
2 Except for the “?” character
3 including the Start, Stop and 
LRc characters. These characters 
are handled automatically by the 
magnetic encoder

STRiPE 1 ^ 210 ppp1
Alphanumeric

(AScii 32-95)2
793

STRiPE 2 = 75 ppp1
Numeric

(AScii 48-62)2
403

STRiPE 3 = 210 ppp1
Numeric

(AScii 48-62)2
1073

• Coercivity sets the magnetic encoding to high (Hico) or low (Loco) coercivity. A magnetic stripe that is encoded with high coercivity is more resistant 
to external disturbance than a magnetic stripe encoded using low coercivity.

• Encoding via an application is used to encode magnetic stripe cards from applications such as Word for example. A text field enclosed within “|” and 
“|” characters (or some other character which the user can define) will be interpreted as an encoding command by print driver.

• Select Assistance&Maintenance>Tools and Diagnostic>Support tools>Encoding to directly encode one or more magnetic stripes: select each 
track and enter the data to be encoded according to the configuration of the stripes. Click on the Encode track(s) button to run the encoding cycle.

Cleaning the magnetic encoder
The magnetic encoder head requires regular maintenance in order to ensure the integrity of the data encoded onto cards.

cleaning of the magnetic encoder is performed when the printer runs an advanced cleaning sequence with T-cards.

Repeatedly running the cleaning card through the printer cleans the card feed rollers, the cleaning rollers, the print head and the magnetic encoder 
read-write head.

if, in between two regular printer cleaning runs, the read-write process fails with more than one card, it is recommended to run an advanced printer 
cleaning sequence manually.

contact smartcard encoding
A printer fitted with a smartcard contact station works in exactly the same way as a basic card printer. The Evolis smartcard contact station is used to 
program chips to ISO 7816-2 standards.

The Evolis product catalogue also includes printers equipped with a chip contact station and a built-in encoder. These encoders are connected to the 
Pc via a USB interface, which does not allow the user to encode with an Ethernet connection.

Contact station location
The contact station is a module installed either in the factory or on site by your Evolis dealer. it is located over the path taken by the cards and after 
the print head. To contact the smartcard, the contact station descends mechanically against the smartcard. The programming sequence for a chip is 
always carried out before the card is printed.
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!
Use only smartcards compliant with the iSO 7816-2 standard.

Printing over the chip may cause permanent damage to the chip.

Card positioning

Smartcards must be placed in the card feeder with the contact chip facing upwards.

Contact station interface

Printers fitted only with a smartcard contact station (without integrated 
encoder) are fitted with a female DB-9 connector on the back of a printer. 
This connector, directly connected to the contact station inside the 
printer, is also connected to an external coupler to program the chip.
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DB-9 connector pins Smartcard contact points

1 c1 (V c.c.)

2 c2 (reset)

3 c3 (clock)

4 c4 (reserved)

5 c5 (ground)

6 c6 (Vpp)

7 c7 (i/O)

8 c8 (reserved)

9 card present signal

NOTE Refer to the Programming Guide for the Evolis printer to get more information on programming a smartcard and the Option 
installation manual for configuration of the card present signal.

A smartcard can be encoded with the cardPresso software or Evolis Premium SDK and the SDK of the encoder.
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contactless smartcard encoding
Evolis printers may be equipped with an encoding device for contactless smartcards (RFiD). This consists of an encoding module and a built-in antenna.

A module such as this must be installed by a specialist. The Evolis product catalogue includes printers equipped with a built-in encoder for contactless 
chips.

This encoder is connected to the Pc via a USB interface. Encoding cannot be performed with an Ethernet connection.

There is a very wide variety of contactless smartcards, and each card has specific technical properties associated with an equally specific type of 
encoder. contact your Evolis dealer for further information.

Location of the antenna (or the encoder with built-in antenna)
By means of a specific command, the card is positioned close to the antenna such that the card lies within its radio range.

Reading data from or writing data to the card can then start.

The programming sequence for a chip is always carried out before the card is printed.

Card positioning
There are no restrictions on card positioning when programming in contactless mode (except for cards comprising other encoding technologies: 
magnetic and/or contact smartcards).

However, the miniaturisation of components is bringing about the emergence of cards fitted with mini-antennae.

if this is the case, please see your card supplier for further information about where such mini-antennae are located within the card, so as to position 
the card as close as possible to the encoder’s antenna. Doing so will ensure optimum encoding of the cards.

Computer connection
if your encoder is supplied with an USB interface, it will either be connected to the printer’s internal USB Hub, or equipped with a USB cable to connect 
to your computer directly.

In the first case, your printer’s USB cable is used to drive firstly the printer and secondly the encoder from the computer.

NOTE Refer to the Programming Guide for the Evolis printer to get more information on programming a contactless smartcard.

A smartcard can be encoded with the cardPresso software or Evolis Premium SDK and the SDK of the encoder.
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SEcURiTy OPTiONS
Digital Erasing
This feature is used to erase data of printing jobs from the printer memory. 

it is used for security reasons.

1 Before launching a printing job, go to Printer Settings>Security and 
activate Data used for printing checkbox.

When the feature is activated, data of all future jobs is erased from the 
printer memory. 

2 Launch the printing job. 

Kineclipse
This feature is used to erase data that is visible on the monochrome and overlay 
panels of the ribbon.

1 Before launching a printing job, go to Evolis Premium Suite>Printer Settings and activate Hide the data 
printed on the ribbon.

 2 Launch the printing job. 

internal basic locking of printer

This option enables to forbid the access to the following elements: 

• card feeder: 100-card or 200-card extension

• Ribbons (and access to the printer sides)

• Reject box capacity is limited to 50 cards

Turn the key on the right to lock Turn the key on the left to unlock 

NOTE 2 keys are provided in the option package

NOTE Scanning, digital erasing, kineclipse and locking options are integrated in the printer. There is no need for on-premises installation.
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Security locking
This option enables to attach the printer with a physical cable.

ScANNiNG
Scanning a printed card (on both sides) is used for the following purposes:

• Have a record of printed cards, 

• Tracking and fraud questions (e.g.: making sure that cards are not printed for personal or wrong purposes), 

• Proofs of printings (may be useful in case of litigation), etc. 

• Optical character recognition capacity to extract textual data (e.g. a barcode) and perform associated actions: automatic creation of user accounts, 
comparison and check of data and/or identity of the card owner, adding of security elements (ex: UV printing of the OcR value read on the overlay 
panel). images that can be retrieved are in PNG, JPG and BMP formats. 

• checking the QR code printed on the card

• Checking of the card rewrite (for certification reasons)

Some scanning parameters may be changed:

• Resolution, 

• Picture format, 

• Scan mode (color, monochrome).

NOTE The scanning option and the contact smartcard encoding station are not compatible.
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cOLOR PROFiLE
Color profile makes the printing as close as possible to the on-screen colors.

!
It is necessary to calibrate the computer before using Evolis color profile. 

The procedure is different according to the Operating System and the computer brand.

On a Windows computer 
By default, Evolis color profile is embarked in Evolis Premium Suite.

To deactivate Evolis color profile, go to Evolis Premium Suite>Printer settings>Printing>Colors>Color settings and click on Do not apply.

On a Macintosh computer

1 Go to Applications>Utilities>ColorSync Utility.

2 From the list on the left, click on the printer. 

3 Click on Current Profile and select Other to assign the profile.  

4 Search for the profile in the following path: System>Library>ColorSync>Profiles>evolis_profile

5 The profile is now assigned to the printer. 



50

PRiMAcy 2

5. MAiNTENANcE
Evolis printers are designed to last long and require minimal regular maintenance. Follow the following instructions to ensure that the printer operates 
correctly.

!
The manufacturer’s warranty is subject to strict adherence to the regular servicing and maintenance instructions, and in particular 
the printer cleaning cycles.

Any failure to follow the maintenance and servicing procedures described in this section voids the print head warranty.

Evolis declines any liability where there has been a failure to perform required maintenance on the printer.

The print head is a wearing part and an extremely sensitive printer component. its life span can be seriously curtailed by the presence of dust, liquids or 
solids in the printer’s immediate environment, on the print head or on the cards. Users must take all necessary precautions to insert only clean cards, 
free of dust deposits or foreign bodies, into the printer.

The frequency and quality of cleaning are decisive factors enabling users to extend the print head’s life span and to ensure excellent print quality.

Particular care must be taken with cleaning.

Users must comply with the servicing and maintenance instructions as fully described in this section.

The Evolis High Trust® consumables have been exclusively designed to work with the Evolis card printers. Tested and validated by the Evolis R&D and

Quality departments, these consumables bring you printing quality and reliability, maximizing the life span of the print head. The use of consumables 
other than Evolis High Trust® may lead to a bad printing quality and a dysfunction of the card printer.

The manufacturer’s warranty does not cover physical damage or quality problems caused by using non-Evolis approved ribbons.

Evolis provides replacement parts and consumables that you can refer to by visiting the website at myplace.evolis.com.
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REGULAR PRiNTER cLEANiNG
Printer cleaning

NOTE Recommended cleaning cycle: whenever the ribbon is changed.

Mandatory cleaning cycle: when the cleaning warning is triggered.

Servicing accessory: adhesive cleaning card.

!
The cleaning warning system of the printer is triggered after a certain number of inserted cards.

Proceed with the regular cleaning of the printer as soon as the warning is triggered.

The print head warranty is directly linked to regular cleaning of the printer. if the regular cleaning is not performed and if the 
warning light remains ON, the print head warranty is automatically voided due to a failure to comply with contractual maintenance 
obligations.

Printer
cleaning required after:

(warning light flashing)

Number of cards remaining before 
warranty voided:

(warning light flashing)

Warranty invalid after

(warning light steady)

Primacy 2 1000 cards 200 cards 1200 cards

For more information, refer to the Cleaning kit safety datasheet.

Follow the procedure to ensure regular cleaning is performed properly:

Repeatedly running the adhesive card through the printer cleans the cleaning roller in order to maintain print quality and increases the service life of 
the print head.
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1 Open the printer cover 2 Remove the ribbon 3 close the cover and press until a click is 
heard.

4 Open the card feeder. 5 Remove the cards and using the lever, set the card thickness to the MAX position.



53

PRiMAcy 2

6 Double-click on the power button on the 
control panel.

7 Remove the film from the adhesive card 1  and insert the adhesive card into the feeder, 
adhesive side up 2  . The cleaning starts.

NOTE When the cleaning is over, the used adhesive card is ejected into the output hopper.

Before using the printer, remember to reset the gauge to the desired card thickness.

cleaning can also be launched from the Evolis Premium Suite properties by clicking on Start cleaning.
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Print head cleaning

NOTE Recommended cleaning cycle: every time the ribbon is changed.

Servicing accessory: cleaning swab impregnated with isopropyl alcohol.

To maintain the original print quality and to absorb surplus ink on the print head, we recommend that the print head is cleaned regularly using the 
cotton buds supplied by Evolis. Protect the print head and its components from any discharge of static electricity.

!
Unplug the printer from its power supply before cleaning the print head.

Follow the cleaning cycles.

Avoid any contact between the print head and any metal or sharp objects. This could permanently damage the print head.

Avoid touching the print head directly with your fingers, as this could affect print quality or permanently damage the print head.

1 Take an Evolis cleaning 
swab and press the 
middle of the tube until 
the end of the cotton 
bud is impregnated 
with alcohol.

2 Unplug the power supply, open the cover, and find the 
print head.

3 Pull the protective cover 
up and gently rub the 
cotton bud from left 
to right along the print 
head for a few seconds.

4 close the cover. 
Reconnect the printer.

NOTE Wait for 2 minutes after cleaning before using your printer.
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ADVANcED cLEANiNG
For a more in-depth clean, we recommend carrying out an advanced clean every five regular cleaning cycles.

Evolis provides an Evolis High Trust® maintenance kit consisting of 2 adhesive cards, 2 impregnated T-cards, a cleaning pen and a box of wipes. The

T-card is used to clean the card feed rollers and the magnetic encoder head.

To ensure advanced cleaning is performed properly, follow the instructions.

Printer cleaning

NOTE Recommended cleaning cycle: every 5 regular cleaning cycles.

When the cleaning is over, the used adhesive card is ejected into the output hopper.

if a yMcKOO ribbon is used, clean the rollers with 1 or 2 cleaning swabs every 1000 cards.

Servicing accessory:
• Impregnated T-card
• Adhesive card.

NOTE Wait for 2 minutes after cleaning before using your printer.

!
The T-card must be used just after the bag is opened.

1 Open the printer cover. 2 Remove the ribbon. 3 close the cover and press 
until a click is heard.

4 Open the card feeder on the 
printer.
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5 Remove the cards and set the card thickness to the MAX position. 6 Double-click the cleaning button on the control panel before 
inserting the cleaning card

7 Take the T-card and insert it into 
the feeder as shown. cleaning 
starts.

8 Remove the T-card. 9 Remove the film from the adhesive card 1  and insert the adhesive 
card into the feeder, adhesive side up 2  . The cleaning starts.
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Print head cleaning

NOTE Recommended cleaning cycle: every 5 regular cleaning cycles.

Servicing accessory: cleaning pen

!
Unplug the printer from its power supply before cleaning the print head.

Follow the cleaning cycles carefully.

Avoid any contact between the print head and any metal or sharp objects. it could damage the print head.

Avoid touching the print head directly with your fingers, as this could affect print quality or permanently damage the print head.

1 Remove the cap of the 
cleaning pen.

2 Unplug the power supply, open the cover, and find the 
print head.

3 Pull the protective cover 
up and gently rub the 
pen from left to right 
along the print head for 
a few seconds.

4 close the cover. 
Reconnect the printer.

NOTE Wait for 2 minutes after cleaning before using your printer.
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Dust filter cleaning

NOTE Recommended cleaning cycle: every 5 regular cleaning cycles.

Servicing accessory: cleaning wipes.

1 Open the printer cover. Locate the dust filter. 2 Locate the dust filter.  
Remove the filter by pulling it upwards and 
slide it out to release it fully.

3 Take a cleaning wipe supplied by Evolis.

4 Clean the filter by rubbing the wipe over 
both sides.

5 Put the filter back. Insert it in its slot (notch 
towards you) and lower it until a click is 
heard.

6 close the cover.
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Lamination module cleaning

NOTE Recommended cleaning cycle: once a year or every 10,000 cards, depending on the work environment.

Servicing accessory: special adhesive cleaning card.

Follow the procedure to perform a lamination module cleaning.

1 Remove lamination film from the lamination unit

2 Launch the lamination module cleaning wizard on the 
Evolis Premium Suite.

3 Remove the two protective films on both sides of the special adhsive 
card.

4 insert the adhesive card into the opening above the output hopper at 
the rear side of the module. The card goes inside the printer.

5 Once the cleaning cycle is complete, the used card is ejected from 
the printer.

6 Put the lamination film back. (See «Inserting lamination film», page 
38.

7 close the door of the lamination unit. The printer is ready to oprate 
again.
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Lamination dust filter cleaning

NOTE Recommended cleaning cycle: every 5 regular cleaning cycles.

Servicing accessory: cleaning wipes.

1 Unplug the lamination module and disconnect it from the printer.

2 The dust filter is located below the lamination unit.

3 Remove the filter by pulling it and slide it out to release it fully.

4 Take a cleaning wipe supplied by Evolis.

5 Clean the filter by rubbing the wipe over 
both sides.

6 Put the filter back. Insert it in its slot (notch towards you) and push it until a click is heard.

7 Reconnect the lamination module to the printer and plug it back.
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Using the leveler
Use the levelers of the lamination module to correct any natural bending of the card caused by the lamination process. cards can be more or less 
misshapen depending on the type of card and film used. 

Two block support positions for the card (A and B) are available to ensure the cards are perfectly flat.

Follow the procedure below:

1 Open the door of the lamination 
module.

2 Loosen the two wheels as 
shown.

3 Depending on the type of card and 
film used, place the block support on 
position A or B (see the table below).

4 Tighten the two wheels 
and close the door of the 
lamination module.

PVc cards PET-F cards Pc cards

1 mil transparent patch
Single-sided B A B
Double-sided B B B

1 mil holographic patch
Single-sided A A B
Double-sided B B B

0.5 mil transparent patch
Single-sided A A B
Double-sided A A B

0.6 mil holographic patch
Single-sided A A B
Double-sided A A B

Varnish
Single-sided A A B
Double-sided B B B

Holographic varnish
Single-sided A A B
Double-sided B B B
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6. HELP
DiAGNOSTic HELP
This section contains all information that could be needed to perform a few simple checks that your Evolis dealer may require.

Printing a technical test card
The technical test card must be printed when the machine is received to ensure your printer operates correctly. This card shows various items of 
technical information concerning the machine (serial number, firmware, cleaning operations, print head, etc.). Your dealer may ask for those items of 
technical information.

1 Wait for any current print jobs to finish.

2 Make sure that there is a ribbon and a card in the printer.

3 Press the power button for four to five seconds until it goes out.

4 Press and hold down the power button again.

5 The power button light comes on.

6 Release the power button once the light flashes.

7 The test card is printed (in color if a color ribbon is fitted in the printer, in monochrome if a monochrome ribbon is fitted, and on both sides if the 
double-sided printing function is activated).

8 The printed card is ejected into the output hopper.

Printing a graphical test card
The graphic test card is used to check the print quality in color or monochrome, the offsets and the synchronization of the ribbon.

To print the graphic test card, make sure there are a ribbon and a card in the printer.

Printing of the graphical and technical test cards can be launched from the menu displayed on the top-right part of 
the Evolis Premium Suite.

identifying installed software versions
Identify the system versions installed (driver, firmware of printer and LCD):

1 in Evolis Premium Suite, go to Assistance&Maintenance>Product information>Software version.

2 click on Software versions.
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TROUBLESHOOTiNG
Printing problems
Nothing prints

1 check the print driver
• Make sure that there is a print driver for your printer in the Windows configuration.

• Make sure that the printer is selected as the default printer.

2 check the printer’s power supply
• Make sure that the power cable is correctly connected to the printer and to a working electrical socket.

• Make sure that the printer is on and that the power button is lit.

• Make sure the power supply unit supplied with the printer is being used.

3 check the USB cable
• Make sure that the USB cable is well plugged on both ports of the printer. 

4 check the ribbon
• Make sure that the ribbon is fitted correctly and that the cover is closed.

5 check the cards
• Make sure that there are cards in the card feeder.

• Make sure that no cards are jammed in the printer.

6 Print a test card
• See “Printing a technical test card”, page 62.

Blank card ejected

1 check the ribbon
• Make sure that the ribbon is not finished or damaged. Replace it or re-install it if necessary.

2 The print head may be damaged
• Print a test card.

if the test card does not print, contact an Evolis dealer for technical support or visit myplace.evolis.com

https://myplace.evolis.com/s/?language=en_US
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Poor print quality

Small blemishes on the card

• The card surface may be dirty.

Check that your cards are perfectly clean.
Use new cards.
• cleaning roller or print head clogged.

Run a cleaning cycle.

Horizontal white lines

• The ribbon is not correctly fitted.

Check that there are no wrinkles on the ribbon surface.
• The print head is dirty or damaged.

Clean or replace the print head.

Blurred image

• The ribbon is not correctly fitted.

Check that the ribbon is correctly positioned in the printer.
• Poor ribbon synchronization.

Open and close the printer cover to synchronize the ribbon.
• Dirty printer or cleaning roller.

Clean the printer.
• Use of incompatible cards.

Check that the cards used match the specifications.
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Partial or incorrect printing

1 check the interface cable
• if irregular characters are printed, make sure the USB cable supplied with the printer is being used.

• Try using another cable of the same type.

2 check that the printer is clean
• clean the printer, especially the cleaning roller.

• See “5. Maintenance”, page 50.

3 check that the cards are clean
• Store the cards protected from dust.

4 check the ribbon
• Make sure that the ribbon is fitted correctly.

• Make sure that the ribbon moves correctly.

5 check the print head
• if horizontal straight lines appear on printed cards, the print head may be dirty or damaged.

See “5. Maintenance”, page 50 and See “6. Help”, page 62.

if the problem persists, contact your Evolis dealer or visit myplace.evolis.com.

NOTE We recommend that you obtain your cards from an Evolis dealer.

Use of cards obtained elsewhere is liable to adversely affect print quality and/or damage the print head.

https://myplace.evolis.com/s/?language=en_US
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Freeing jammed cards
Control panel displays:

MECHANICAL ERROR
• A card is jammed in the printer. Print jobs are interrupted.

The printer light and the control button are ON.

!
Do not turn your printer off, as this cancels pending print jobs in the printer’s memory.

Remove the card as follows:

1 Open the printer cover and remove the ribbon.

2 Press the power button to activate the card feed rollers. if the card is still stuck inside the printer, slide it manually towards the printer output. if 
there is more than one card, always push the top one first.

3 Replace the ribbon, then close the printer cover.

To prevent card jams:

1 Make sure that the card thickness gauge is correctly adjusted.

2 Make sure that the thickness of the cards used matches the specifications.

3 Make sure that the cards are flat. Keep them in a horizontal position. 

4 Make sure that the cards are not stuck together. Shuffle the cards before loading them.
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Replacing the print head
The print head is a sensitive component of the printer. it determines the print quality. A regular cleaning and an environment free from dust or other 
particles ensure a lengthy useful life. See “Print head cleaning”, page 54 to clean the print head.

in case the user needs to replace the print head, Evolis designed a unique device that requires no tools for the replacement.

Before replacing the print head, contact your Evolis dealer. The dealer can give advise and supply a new print head if necessary.

NOTE For more information on print head warranties, refer to the Evolis warranty available on myplace.evolis.com.

!
Unplug the printer before replacing the print head.

Avoid touching print heads with bare hands.

Follow the instructions carefully.

Removing the defective print head

1 Open the printer cover. 2 Locate the print head. 3 Press on the plastic part behind the print head 
(pressure plate) 1 .

4 Pull on the print head with the other hand as 
shown to free the lugs from the holding fork 2 .

5 Remove the lugs from their slots.

6 Tilt the head carefully downwards and disconnect the connector linked to the cable.
Avoid forcing the mechanism.

https://myplace.evolis.com/s/?language=en_US
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Installing the new print head

7 Note the code (PKN number) on the white 
label of the print head. This code is needed 
later in the procedure.

8 Take the new print head and insert it 
vertically (white connector upwards), raising 
it in the two guides so as to trap the lugs of 
the fork in their slots 1 . Then lower it by 
pressing on the two forks 2 , a click will be 
heard.

9 connect the cable into its socket, making 
sure it is the right way round. Do not use 
any force, as this part is relatively fragile. 
Press down on each side of the connector to 
ensure a good connection is made

10 The new print head is installed. 11 Close the cover. The print head is now fitted.
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Configuring the new print head

12 Power on the printer and make sure that it is properly connected to a computer on which the Evolis Premium Suite is installed.

13 From Evolis Premium Suite, go to Assistance and Maintenance>Maintenance>Print head replacement.

14 Enter the PKN number of the print head kit in Enter PKN No. (noted in step 7). Then Validate PKN.

!
if the PKN number is not entered correctly, printer malfunctions may occur and the warranty may be voided.

Cleaning the printer
The “CLEANING” light is ON  on the LED panel.

Once the cleaning of the print head is done, the printer is ready to be used.

!
Cleaning is absolutely necessary after changing the print head. No print jobs can be run until the cleaning operation has finished.

See “Print head cleaning”, page 54.



70

PRiMAcy 2

Updating the firmware 

!
An update of the firmware that is not properly performed may result in a malfunctioning printer.

Before updating the firmware, contact your Evolis dealer.

Firmware updates are only required in case of an issue or a malfunction clearly identified by your Evolis dealer.

interrupting the transfer between computer and printer during the download phase (powering off the printer or computer, 
unplugging a cable) would make it impossible to restart the printer. if such an incident occurs, contact your Evolis dealer to replace 
the printer’s processing board.

On Windows
The update of the firmware is performed with the Evolis Premium Suite.

1 Download the file (.firm) from myplace.evolis.com.

2 Open Evolis Premium Suite and double-click on the name of the printer. Go to Assistance and Maintenance>Software updates>Printer 
firmware>Start the updates wizard.

3 Follow the instructions and select the file .firm that was just downloaded.

4 The operation may take up to 1 minute. When the firmware is installed, the printer restarts. The update is complete and the printer is ready for use.

5 if the printer is not showing a Ready status, this means that the update was not performed correctly or, that the printer is not working properly. 
check the connection cables and run a new update.

On Macintosh

1 Download the file (.firm) from myplace.evolis.com.

2 Go to Menus & preferences, Printers and scanners, and select your printer. Go to Options & supplies, Utility and click Open printer utility. The 
Evolis card Printer window opens. All you need to do now is click on Upgrade.

3 Select the folder where you extracted the downloaded file and open the firmware file (.firm).

4 When prompted by the programme, follow the instructions in order to select the printer and start the operation. The firmware transfer is in 
progress.

5 After about thirty seconds, the firmware is transferred to the printer and the operation is complete.

6 Check the firmware version by clicking on Identify.

7 if the printer is not showing a Ready status, this means that the update was not performed correctly or, that the printer is not working properly. 
check the connection cables and run a new update.

NOTE In case of problems during the update of the firmware on Windows or Macintosh, contact your Evolis dealer who can provide a new 
installation file for the firmware.

https://myplace.evolis.com/s/?language=en_US
https://myplace.evolis.com/s/?language=en_US
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Updating the print driver
Updating the print driver is a task that is required in order to fix malfunctions or gain the benefit of new options.

!
Before any update, contact your Evolis dealer for advice or guidance on performing the update.

1 Download the file from myplace.evolis.com.

2 Then click on the file for the corresponding print driver.

3 Accept the download then save the file in a directory on your hard drive.

4 Extract the .zip file of the print driver.

5 Then double-click on the file (setup.exe for Windows or .pkg for Mac) to start the installation program.

NOTE The print driver can also be updated in the Evolis Premium Suite.

https://myplace.evolis.com/s/?language=en_US


72

PRiMAcy 2

TEcHNicAL SUPPORT
If you are having difficulties in configuring and using your printer, read this manual carefully.

if you do not manage to solve your problem, you can obtain further information and help from the Evolis partner network.

Evolis partner network
For unresolved technical problems, contact your Evolis dealer. 

if you do not know any Evolis dealers, contact us to have the contact information of the nearest Evolis dealer. When calling an Evolis dealer, make sure 
to be close to a computer and to provide the following information:

• Printer model and serial number

• The version of your mobile operating system.

• A description of the incident

• A description of what was performed to try and resolve the incident

In addition, to enable you to find answers to your questions 24/7, myplace.evolis.com includes a number of aspects related to day-to-day use of the 
printer.

Finding information on myplace.evolis.com
if additional technical help is needed, information on using and troubleshooting Evolis printers is available on myplace.evolis.com.

• Latest versions of firmware,

• Print drivers

• User manuals

• Videos about using and maintaining Evolis printers

• A knowledge base to find answers to your questions

https://www.evolis.com/contact/
https://myplace.evolis.com/s/?language=en_US
https://myplace.evolis.com/s/?language=en_US
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7. DEcLARATiONS OF cONFORMiTy
In this section, you will find the certifications for your Evolis printer.

GENERAL

Concerning Safety and Electromagnetic Compatibility of Radio Equipment 
(RED 2014/53/EU, LVD 2014/35/EU, EMC 2014/30/EU Directives) and (RoHS3) 
2015/863/EU:
Manufacturer name: Evolis
Manufacturer address: 14, avenue de la Fontaine
 Z.i. Angers Beaucouzé
 49070 Beaucouzé, France
Equipment name: Primacy 2
Year of manufacture: 2022
i, the undersigned,
Laurent Godard, 
Declare under my own responsibility that the product here above described 
complies with the essential applicable requirements, (particularly with those of 
the RED 2014/53/EU, LVD 2014/35/EU, EMC 2014/30/EU Directives and (RoHS3) 
2015/863/EU as follows:

Article 3.1 a: (electromagnetic compatibility protection requirement)

Safety standard applied EN62368-1: 2014
 EN50364: 2010

Article 3.1 b: (electromagnetic compatibility protection requirements)

EMC standard applied EN55032: 2012
 EN55024: 2010           
 EN61000-3-2: 2014
 EN61000-3-3: 2013
 EN301489-3: 2013 (VI.6.1)

Article 3.2: (Good use of the radio frequency spectrum to avoid undesirable interferences)

EMC standard applied EN300330-2 V1.6.1
Full name: Laurent Godard
Position: R&D Director
Date: January 4th 2022
Signature: 
EUROPE - Norway Only: This product is designed for iT power system with phase-to-phase voltage 
230 V. Earth grounding is via the polarised, 3-wire power cord.
Fi: “Laite on liitettävä suojamaadoitus koskettimilla varustettuun pistorasiaan”

SE: “Apparaten skall anslutas till jordat uttag”

NO: “Apparatet må tilkoples jordet stikkontakt”
DK : „Apparatets stikprop skal tilsluttes en stikkontact med  jord, som giver forbindelse til 
stikproppens jord“.

FCC Statement (For U.S.A.)

Federal Communications Commission Radio Frequency Interferences Statement

Primacy 2 model conforms to the following specifications: FCC Part 15, Subpart 
A, Section 15.107(a) and Section 15.109(a) class B digital device.

Supplemental information:
This equipment has been tested and finds to comply with the limits for a Class B digital device, 
pursuant to part 15 of the Fcc Rules. These limits are designed to provide reasonable protection 
against harmful interference in a residential installation. This equipment generates uses and can 
radiate radio frequency energy and, if not installed and used in accordance with the instructions, 
may cause harmful interference to radio communications. However, there is no guarantee that 
interference will not occur in a particular installation. if this requirement does cause harmful 
interference to radio or television reception, which can be determine by turning the equipment off 
and on, the user is encouraged to try to correct the interference’s by one or more of the following 
measures: 
- Reorient or relocate the receiving antenna.
- increase the separation between the equipment and the receiver.
- connect the equipment into an outlet on a circuit different from that to which the receiver is 
connected.
- consult the dealer or an experienced radio/TV technician for help.
Use of a shielded cable is required to comply within class B limits of Part 15 of Fcc Rules.
Pursuant to Part 15.21 of the FCC Rules, any changes or modifications to this equipment not 
expressly approved by Evolis may cause, harmful interference and void the Fcc authorization to 
operate this equipment.
it is recommended to respect a distance of 20 cm between user and RFiD module when the 
module is powered. 
This device complies with industry canada licence-exempt RSS standard(s). Operation is subject 
to the following two conditions: (1) this device may not cause interference, and (2) this device must 
accept any interference, including interference that may cause undesired operation of the device.

VCCI (For Japan)
This is a class B product based on the standard of the Voluntary control council for interference 
from information Technology Equipment (Vcci). if this is used near a radio or television receiver in 
a domestic environment, it may cause radio interference. install and use the equipment according 
to the instruction manual.
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UNITED-KINGDOM
Concerning Safety and Electromagnetic Compatibility of Radio Equipment 
(RED 2014/53/EU, LVD 2014/35/EU, EMC 2014/30/EU Directives) and (RoHS2) 
2011/65/EU:
Manufacturer name: Evolis
Manufacturer address: 14, avenue de la Fontaine
 Z.i. Angers Beaucouzé
 49070 Beaucouzé, France
Equipment name: Primacy 2
Year of manufacture: 2022
i, the undersigned,
Laurent Godard, 
Declare under my own responsibility that the product here above described 
complies with the essential applicable requirements, (particularly with those of 
the RED 2014/53/EU, LVD 2014/35/EU, EMC 2014/30/EU directives and (RoHS2) 
2011/65/UE as follows:

Article 3.1 a: (electromagnetic compatibility protection requirement)

Safety standard applied BS-EN62368-1 : 2014
 BS-EN50364:2010

Article 3.1 b: (electromagnetic compatibility protection requirements)

EMC standard applied BS -EN55032: 2012
 BS -EN55024: 2010           
 BS -EN61000-3-2 ; 2014
 BS -EN61000-3-3 : 2013
 BS -EN301489-3 : 2013 (VI.6.1.)

Article 3.2: (Good use of the radio frequency spectrum to avoid undesirable interferences)

EMC standard applied BS-EN300330-2 V1.6.1
Full name: Laurent Godard
Position: R&D Director
Date: January 4th 2022
Signature: 
EUROPE - Norway Only: This product is designed for iT power system with phase-to-phase voltage 
230 V. Earth grounding is via the polarised, 3-wire power cord.
Fi: “Laite on liitettävä suojamaadoitus koskettimilla varustettuun pistorasiaan”

SE: “Apparaten skall anslutas till jordat uttag”

NO: “Apparatet må tilkoples jordet stikkontakt”
DK : „Apparatets stikprop skal tilsluttes en stikkontact med  jord, som giver forbindelse til 
stikproppens jord“.

FCC Statement (For U.S.A.)

Federal Communications Commission Radio Frequency Interferences Statement

Primacy 2 model conforms to the following specifications: FCC Part 15, Subpart 
A, Section 15.107(a) and Section 15.109(a) class B digital device.

Supplemental information:
This equipment has been tested and finds to comply with the limits for a Class B digital device, 
pursuant to part 15 of the Fcc Rules. These limits are designed to provide reasonable protection 
against harmful interference in a residential installation. This equipment generates uses and can 
radiate radio frequency energy and, if not installed and used in accordance with the instructions, 
may cause harmful interference to radio communications. However, there is no guarantee that 
interference will not occur in a particular installation. if this requirement does cause harmful 
interference to radio or television reception, which can be determine by turning the equipment off 
and on, the user is encouraged to try to correct the interference’s by one or more of the following 
measures: 
- Reorient or relocate the receiving antenna.
- increase the separation between the equipment and the receiver.
- connect the equipment into an outlet on a circuit different from that to which the receiver is 
connected.
- consult the dealer or an experienced radio/TV technician for help.
Use of a shielded cable is required to comply within class B limits of Part 15 of Fcc Rules.
Pursuant to Part 15.21 of the FCC Rules, any changes or modifications to this equipment not 
expressly approved by Evolis may cause, harmful interference and void the Fcc authorization to 
operate this equipment.
it is recommended to respect a distance of 20 cm between user and RFiD module when the 
module is powered. 
This device complies with industry canada licence-exempt RSS standard(s). Operation is subject 
to the following two conditions: (1) this device may not cause interference, and (2) this device must 
accept any interference, including interference that may cause undesired operation of the device.

VCCI (For Japan)
This is a class B product based on the standard of the Voluntary control council for interference 
from information Technology Equipment (Vcci). if this is used near a radio or television receiver in 
a domestic environment, it may cause radio interference. install and use the equipment according 
to the instruction manual.
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